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Komputer For Alle blade
Adobe Photoshop Album SE K-02-06 Fotoalbum
Ashampoo Photo Optimizer 4 K-02-13 Avanceret fotobehandling på dansk
Clean Skin FX internet Udglatter automatisk uren hud på portrætter
ConceptDraw V K-16-05 Tegne diagrammer og indretning
Fast Image Resizer 0.97 internet Supernem formindskning af billeder
Fotosizer K-01-13 Mange muligheder ved ændring af billedstørrelse
GIMP 2.2.9 K-02-06 Avanceret billedbehandling på dansk
Image Resizer K-14-05 supernem formindskning af billeder
Inkscape K-12-10 Avanceret vektortegneprogram
IrfanView 3.75 engelsk K-13-02 side 28
IrfanView 3.95 diskette
IrfanView 3.97
IrfanView engelsk K-01-04 side 76
Magix Xtreme Photo Designer K-07-11 side 60 Rund rød-øje-markering
Paint Brush diskette Simpel maleprogram
Paint.NET K-13-07 Sammenlæg 2 billeder. Serie fra nr. 10

Kan arbejde med lag, fritlægning og ny baggrund
Pixia 2.8 K-09-03
Pixum-Up K-17-03 side 54
Paint Shop Pro 4.12 K-09-98
Paint Shop Pro 5.01 K-11-98
Red Eye Remover Pro http://www.vicman.net/redeyeremoverpro/index.htm

Lille, nem og enkel guidebaseret. Godt resultat.
Serif photoPlus 6 K-05-05
XnView K-03-04 side 70 Fotobehandling
XnView 1.74 K-05-05 Fotobehandling
XnView 1.82 Fotobehandling
Zara XS K-03-06 og K-04-09 Fotobehandling og vektortegneprogram

Indstillinger ved scanning K-17-08 side 58



Programmer til fjernelse af røde øjne
Ashampoo Photo Optimizer 4
GIMP 2.2.9
IrfanView
Magix Xtreme Photo Designer
Paint.NET
Pixia 2.8
Pixum-Up
Paint Shop Pro
Serif photoPlus 6
XnView 1.97 Firkant. Kun det røde i pupilen farves sort, ikke spejlingen.
Zara XS
Red Eye Remover Pro Firkant. Kun det røde i pupilen farves sort, ikke spejlingen.

Red Eye Remover Pro
Godt program til fjernelse af røde øjne. Enkel program som er guidebaseret. Forfæller selv
undervejs hvad man skal gøre. Ved gemning er det bedst at sætte flueben ved Save with
original quality – så bliver filstørrelsen kun lidt mindre.
Ved gemning opretter programmet selv en undermappe til den mappe billedet er hentet fra, og
kalder den Output. Her placeres de billeder som behandles.



Image Resizer til XP (virker ikke i Windows Vista)
Denne smarte udvidelse til Windows giver i højrekliksmenuen et nyt menupunkt - Resize Picture
- som gør det nemt at lave billeder om til en ny mindre størrelse. Kan både bruges til et enkelt
billede, og til mange billeder på en gang. Der sker ikke noget med de originale billeder. De små
billed-udgaver lægges i samme mappe, og får en tilføjelse i filnavnet som f.eks. Large.
Billeder som ikke har sideforholdet 4:3 bevarer det når der laves små udgaver.

Mindre billeder
Markér de billeder som skal kopieres til mindre størrelse > højreklik på en af dem > vælg Resize
Pictures > vælg størrelse > klik OK.
Billederne bliver kopieret til ny størrelse, og placeret i samme mappe. Filnavnet får tilføjet
størrelsen.

Small 640 x 480 = ca. 20 x 15 cm
Medium 800 x 600 = ca. 14” skærm
Large 1024 x 768 = ca. 17” skærm
Handheld PC 240 x 320 = ca. 5 x 7 cm

Hvis du skal bruge en bestemt størrelse: Klik på knappen Advanced > vælg punktet Custom >
indtast den ønskede vandrette størrelse i første felt > OK
(programmet regner selv højden ud så sideforholdet bevares.)

Der findes også en udgave til Windows 7
https://imageresizer.codeplex.com/

Fast Image Resizer 0.97
Under installation klikkes hver gang på den knap som er markeret.

Indstil programmet
Åben programmet og klik på knappen Options.
I feltet Subfolder ændres teksten resized til Mindre billeder.
Marker firkanten ved Always on top.
Klik på OK.

Mindre billeder
Åben mappen med de billeder som skal laves mindre (der sker ikke noget med
originalbillederne – der laves kopier).
Åben programmet Fast Image Resizer.
Marker de billeder som skal laves mindre. En række markeres ved at holde tasten SHIFT nede
medens der klikkes på den første og den sidste. Spredte billeder markeres ved at holde tasten
CTRL nede medens der klikkes på de ønskede billeder.
Træk derefter et af billederne over i området Drop files here. Når musetasten slippes, laves de
små billeder og gemmes i en undermappe.

Vælg billedstørrelse
En anden billedstørrelse end den programmet er indstillet til ved installation, kan vælges ved at
klikke på pil-ned i feltet Resolution.



XnView
Gemme
Når billeder gemmes efter redigering, bliver filstørrelsen for det meste halveret til lidt under halv.
I nogen tilfælle bliver filstørrelsen kun lidt mindre.

Tilpasninger efter installation, ver. 1.80
- Vis > Layout. Vælg den midterste.
- Vis > Preview > Automatisk billedstørrelse > Tilpas billede kun store.
- Værktøjer > Indstillinger > Vis > Tastatur/Mus. I dropdownmenuen ved Markør venstre/højre
vælges Forrige/næste.
- Værktøjer > Instillinger > Browservisning. Vælg Specificeret, og klik på knappen med 3 prikker.
Find din mappe med billeder, marker og klik OK.

Tilpasninger efter installation, ver. 1.82
- Vis > Layout. Vælg den 3. øverste.
- Værktøjer > Indstillinger > Vis. I dropdownmenuen til højre for Automatisk billedstørrelse
vælges Tilpas billed til vindue, kun store.
- Værktøjer > Indstillinger > Vis > Tastatur/Mus. I dropdownmenuen ved Markør venstre/højre
vælges Forrige/næste.
- Værktøjer > Instillinger > Browservisning. Vælg Specificeret, og klik på knappen med 3 prikker.
Find din mappe med billeder, marker og klik OK.

Tilpasninger efter installation, ver. 1.914
- Vis > Layout. Vælg den 3. øverste.
- Værktøjer > Indstillinger > Vis. I dropdownmenuen til højre for Automatisk billedstørrelse
vælges Tilpas billed til vindue, kun store.
- Værktøjer > Indstillinger > Generelt > Tastatur/Mus. I dropdownmenuen ved Markør
venstre/højre vælges Forrige/næste.
- Værktøjer > Indstillinger > Generelt > fanebladet Operationer. I området Start vælges
Specificeret > klik på knappen med 3 prikker > find din mappe med billeder > marker og klik OK.
- Værktøjer > Indstillinger > Læs/Skriv > fanebladet Skriv > klik på JPEG > indstil Kvalitet til 90 >
OK.

Juster lys og kontrast, ver 1.80
Klik på billedet og tryk på tasten Enter for at åbne billedet til redigering > i menulinjen klik på
Billede > vælg Tilpas > Lysstyrke/kontrast…. Eller ikonet med skydere.
Som tommelfingerregel skal kontrasten ændres 1/5 af lysstyrken. Ændres lysstyrken f.eks. 25
skal kontrasten ændres 5 i samme retning.
I stedet for skyderne Lys og Kontrast, kan skyderen Gamma bruges.

Fjern røde øjne
Klik på billedet og tryk på tasten Enter for at åbne billedet til redigering > klik på ikonet Zoom ind
nogle gange så øjet bliver så stort som en fingernegl > træk med musen en firkant om øjet >
finjuster ved at trække i de små hjørneklodser > klik på ikonet Fjern røde øjne.

Ver 1.97
I denne vertion fungerer funktionen godt. Det gør ikke noget at firkanten er noget uden for
pupillen. Pupillen bliver sort og spejlingen bevares.

Ny mappe
Markér den mappe som skal have en ny undermappe > klik i menulinjen på Edit > vælg Ny
Mappe. Den nye mappe findes nu under + tegnet ved den valgte mappe.



Beskær billede
Billed-side-forhold
3-2 = 10 x 15    billede Liggende 1,50 Stående 0,66 Mest spejlrefleks-kamera
4-3 = 10 x 13,3 billede Liggende 1,33 Stående 0,75 Mest lomme-kamera

Træk en firkant med venstre musetast > klik på sakse-ikonet. Fortryd med pilen ved saksen.
Hvis billedet er en del af en serie, så juster beskæringsrammen så side-forholdet er det samme
som originalbilledet . Forskellige side-forhold er forstyrrende at se på, og det giver problemer
hvis billederne engang skal på papir hos fotohandleren.

Ny størrelse, ver. 1.78
Lav en ny undermappe til den mappe billederne ligger i.
Klik i 2. Værktøjslinje på ikonet Ny mappe > skriv et mappenavn, f.eks. Mini > tryk på tasten
Enter.
Marker de billeder du ønsker at kopiere til en ny størrelse > højreklik på et af dem > vælg
Konvertér… > til højre for feltet Bibliotek klikker du på knappen med 3 prikker > find frem til og
vælg den mappe de formindskede billeder skal ligge i > klik OK > klik på knappen Avancerede
opgaver > i rullemenuen vælges Ny størrelse > klik på knappen ---> > skriv den nye bredde eller
højde > klik OK > klik Start.
Når statusbaren er forsvundet klikker du på Afbryd.

Ny størrelse, ver. 1.82
Lav en ny undermappe til den mappe billederne ligger i.
Højreklik på den mappe som skal have en ny undermappe > Ny Mappe > skriv et mappenavn,
f.eks. Mini > tryk på tasten Enter.
Marker de billeder du ønsker at kopiere til en ny størrelse > højreklik på et af dem > vælg Multi
konvertér… > til højre for feltet Mappe klikker du på knappen med 3 prikker > find frem til og
vælg den mappe de formindskede billeder skal ligge i > klik OK > klik på fanebladet
Transformations > i rullemenuen vælges Ny størrelse > klik på knappen Add > skriv den nye
bredde f.eks. 1024, eller højde f.eks. 768 > klik Start.

Sorter billeder i optagelses-rækkefølge
Klik i nederste ikonlinje på ikonet med en blå pil og AZ > vælg EXIF dato.

Ændre billedrækkefølgen, ver 1.78
Start som ved omdøbning af alle billeder i en mappe. Under kolonnen Gamle navn klikker du på
det billede du vil flytte, og derefter på pilene op eller ned i højre side. Omdøb derefter billederne
så der tilføjes en nummerering. Se afsnittet Omdøb flere billeder.



Omdøb et billede
Højreklik på billedet > vælg Omdøb… > tryk på en piletaste > ændre navnet (filtypenavnet skal
bevares) > tryk på tasten Enter.

Omdøb flere billeder, ver 1.97
Marker de billeder som skal omdøbes > højreklik på en af dem > vælg Omdøb … > sæt flueben
ved Navngivningsskabelon og skriv det nye navn i feltet under.

Du skal nu vælge en tilføjelse til navnet. Det kan enten være en nummerering, eller en af de
oplysninger du finder under knappen Indsæt>>. Hvis du vil nummerere billederne, så indtast
blot det antal ”havelågetegn” (#) efter navnet som svarer til det antal cifre der er i billedantallet.
Altså, hvis der er valgt 14 billeder, sættes 2 ”havelågetegn”.
”Havelågetegnet” findes på tasten 3. Hold tasten SHIFT og tryk på tasten 3.
Hvis fil-navnet ønskes bevaret i det nye navn, klik på knappen Indsæt>> og vælg Filnavn.
Det er klogt at bevare filnavnet, for så er det meget lettere senere at finde et bestemt billede.

Eksempel:
Ferie Bornholm ### bliver til Ferie Bornholm 047.jpg
### <Filnavn> bliver til 047 SAM0002-3751.jpg
### Ferie Bornholm <Filnavn> bliver til 047 Ferie Bornholm SAM0002-3751.jpg

Start omdøbningen ved at klikke på knappen Omdøb. Nederst til højre vises en bare med
fremgangen.

Omdøb alle billeder i en mappe, ver 1.78
Marker alle billederne i mappen > højreklik på en af dem > vælg Omdøb batch… > sæt flueben
ved Brug aktuelle, og skriv det nye navn i feltet under.
Du skal nu vælge en tilføjelse til navnet. Det kan enten være en nummerering, eller en af de
oplysninger du finder under knappen Indsæt…. Hvis du vil nummerere billederne, så indtast blot
det antal ”havelågetegn” (#) efter navnet som svarer til det antal cifre der er i billedantallet.
Altså, hvis der er 103 billeder i mappen, sættes 3 ”havelågetegn”.
”Havelågetegnet” findes på tasten 3. Hold tasten SHIFT og tryk på tasten 3.
Start omdøbningen ved at klikke på knappen Omdøb.

Fjern turister fra et feriebillede
www.snapmania.com/info/en/trm



IrfanView 3.97
Dansk sprog
Placer den danske sprogfil (dansk.dll) i mappen C:\Programmer\IrfanView\Languages.
Options > Change language…. Vælg Dansk og klik OK.

Tilpasninger efter installation
- Vis > Fremvisningsindstillinger. Vælg Tilpas kun store billeder til vindue.
- Filer > Åbn…. Der skal være flueben i Miniature.

MOV-video-filer
For at vise MOV-video-filer skal IrfanView Plug-in installeres.



Paint.NET
Dansk sprog
Der er lavet en oversættelse af det lille billedbehandlingsprogram Paint.NET version 3.5.3
februar 2010. Virker også i version 3.5.6.
Det er endnu ikke lykkedes at pakke oversættelsen sammen med resten af
programinstallationen, men følg vejledningen nedenfor, så får du Paint.NET i en dansk udgave.

1. Download følgende fil: PaintDotNet.Strings.3.da.resources ved at klikke på linket.
2. Flyt den ind i mappen Paint.NET (C:\Programmer\Paint.NET).
3. Download herefter følgende fil: Files.AboutCredits ved at højreklikke på linket og vælge Gem

destination som…
4. Opret en undermappe i mappen Resources, og kald den da

(C:\Programmer\Paint.NET\Resources\da).
5. Flyt filen Files.AboutCredits ind i mappen da.

Den engelske version af Paint.NET skal naturligvis være installeret på din computer. Er den
ikke det, kan den hentes her: Paint.Net eller http://www.getpaint.net

Start Paint.NET og klik i menulinjen på Utilities > Languages > dansk. Måske skal du lukke
programmet ned og starte det igen for at få dansk sprog.

Beskær
Træk en rektangel om med værktøjet Vælg rektangel.
Flyt rektanglets sider med værktøjet Flyt det valgte.
Menulinjen Billede > Beskær det valgte.

Frilægning K-11-07
Før fritlægning begyndes, gemmes billedet i Paint.NETs eget filformat. Filer > Gem som. I
dropdown listen Filnavn vælges Paint.NET (*.pdn).
Fritlægning betyder at man fjerner noget af billedet. Ikke at forvæksle med beskæring eller at
erstatte en farve eller noget i billedet med noget andet. Der hvor man fritlægger kommer der
grå-hvide tern. Det betyder at der er ingenting.
Der er flere metoder til fritlægning. Nogen af dem er Viskelæder, Tryllestav og
Frimarkeringsvalg.
Laver man en fejl under fritlægningen, kan man bare gå tilbage med knappen Fortryd i
ikonlinjen eller boksen Historik. Gem undervejs og til sidst.

Ny baggrund   (lag)
Når det ønskede på billedet er fritlagt, og noget andet ønskes i stedet for, f.eks. en farve,
oprettes et nyt lag. Klik i boksen Lag på ikonet Tilføj nyt lag. Det nye lag placerer sig automatisk
over billedet – det dur ikke. Der står godtnok Baggrund på billed-laget, men det er noget
sludder. Klik på det nye Lag 2 så det er markeret, dernæst på ikonet Flyt lag nedad.
Skal den nye baggrund f.eks. have en farve, så klik i boksen på Lag 2 så den er markeret > klik
i boksen Farver på en farve > klik i boksen Værktøj på Malespand > klik der hvor der er grå-
hvide tern. Du kan skifte farve på Lag 2 lige så mange gange du har lyst, til du finder den
ønskede farve. Med fluebenene i boksen Lag kan du koble lagene fra eller til.

Vælg farve
I boksen Farver vælges farven. Den valgte farve vises i den øverste af de 2 store firkanter.
Farven kan vælges på flere forskellige måder: Små farve-firkanter, farve-cirkel og avanceret
under knappen Mere.
Speciel valg af en grå nuance. Klik på knappen Mere > flyt den sorte trekant på farve-baren V.



Klone
Fjern en billedfejl ved at klone fra et andet sted på billedet.
Klik på Klon Stempel > hold tasten CTRL og klik der hvor der skal klones fra > slip CTRL > klik
på billedfejlen. Størrelsen af stemplet vælges ved Penselbredde.

Udjævn kant mellem lag
Brug funktionen Feather. Menulinjen Effects > Blurs > Feather. Eller Menulinjen Effekter >
Object > Feather. Stil værdien til 2.
Der skal muligvis installeres et plugin for at funktionen er tilgængelig.

Hent plugins
Plugins må IKKE hentes andre steder end her – for der er sandsynligvis virus i.
http://forums.getpaint.net/index.php?/topic/15260-plugin-index/#entry252079
To install, download this file to your C:/Program Files/Paint.NET/Effects folder and unzip it.

Sammenlæg lagene og gem færdigt billede
Når billedet gemmes i formatet JPG, lægges lagene sammen automatisk lige inden billedet
gemmes.
Menulinjen Filer > Gem som > i Filtype vælges JPEG. Kvaliteten stilles til 95. Klik på Fladgør.

Menuen Lag på engelsk Layers
Tilføje nye lag

Dette vil tilføje et nyt, gennemsigtigt lag til billedet.

Slet lag
Dette vil fjerne det aktive lag fra billedet. Du vil blive bedt om at bekræfte dette er, hvad du
ønsker at gøre, før den slettes.

Dubler lag
Dette vil lave en nøjagtig kopi af det aktive lag. Alle egenskaberne for lag, sammen med
de grafiske (pixel) indhold, vil blive duplikeret. Det nye lag vil også have det samme navn
som oprindelige.

Flet lag nedad
Dette vil tage det aktuelle lag og flette det ind i det lag, der er under den.

Importer fra fil
Dette giver dig mulighed at vælge et eller flere billeder, der skal importeres som et eller
flere nye lag.

Spejlvend vandret eller lodret
Disse menupunkter kan spejlvende det aktive lag, enten vandret eller lodret.

Rotere / Zoom
Denne kommando tillader dig at rotere og panorere i alle tre dimensioner. For mere
information om, hvordan du bruger dette værktøj, kan du besøge afsnittet Rotere / Zoom-
værktøjet.

Lag-egenskaber
Denne kommando åbner en dialogboks, der gør det muligt at definere hvordan lag smelter
sammen med de lag, der er under i lag-vinduets liste. Du kan angive: Et navn, om lag er
synlige, en blandingstilstand og et gennemsigtigheds-niveau. Skyderen Gennemsigt styrer
hvordan gennemsigtige lag er samlet (smeltet sammen).
For mere information om blandingstilstande af lag, besøg afsnittet Blandingstilstande.



Scanning med Mira Scan v5.0
Billeder – farve
Color

Billeder – grålige
Gråtone

Billeder – stregtegninger
IrfanView > Filer > Scan/multi-scanning… > vælg Enkelt billede eller Flere billeder > OK.
Scannerprogrammet åbner.
Mira Scan v5.0
Kør en preview-scanning > klik på Open job settings > klik ud for Image type 2 gange og vælg
Line-art.
Scan mode High Speed
Resolution 300 dpi
Scaling 100%

Lyset kan justeres ved at klikke på knappen Open Image Adjustment > vælg fanebladet
Threshold > klik på den sorte pil under ”bjerglandskabet” og træk den til siderne > godkend med
knappen Apply (den buede pil) > luk vinduet med krydset. Man kan både godkende og lukke
vinduet ved at klikke på OK (fluebenet).
Ændringen kan sættes tilbage til det scanningsprogrammet foreslår, ved at klikke på knappen
Reset (den med cirkelpilen).

Udskriv stregtegning
IrfanView > Filer > Print… > vælg printer og papirretning.
Ved A4 tegning: Hvis printeren ikke kan printe helt ud til kanten, vælges i området papirstørrelse
Manuelt > bredden stilles til 20 og flueben i Proportionelt.
I området Position sættes flueben i Centrer billede > Udskriv.

Billeder – fra en avis (raster / prikker)
Descreen eller moiré mønster

Tekst
Line-art

Tekstside med sort-hvid billede
Gråtone


